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Chapter 1:
Introduction (do you want to call it this? ***)

General Introduction (or whatever you choose***)

Summarization is a ubiquitous and essential element of human communication.  Not surprisingly, it’s also a common pedagogical activity.  Blah, blah, blah blah blah!  Write something more riveting than I did, will ya?

Why Summarization?

More blahing going on here.  But you might want several subsections, so here's another one to demonstrate.  And as a bonus, here's an example of another style I put together for block quotations (according to APA, that's 40 words or more).  To make a block quotation, start a new paragraph, and then change it's style to 'Quotation'.  (I set up my toolbars to have the style pull-down appear.  I think it may be there as the default, but if not, I recommend displaying the formatting toolbar – select 'Toolbars > Formatting' from the View menu.)  Immediately following the quote, the text starts up again, and (again according to APA) is supposed to appear as a continuation of the same paragraph (well, at least in the way I wrote this one.  I guess you could end a paragraph with a block quotation.  But I digress!)  So the style of the next paragraph is not normal, but another (kinda kludgy) style I made up, 'Normal – flush first line'.  I made the quotation style so that when you press return (to start the next paragraph), it should automatically be 'Normal – flush first line'.  But you may want to look in the style window to make sure.

Perhaps one of the best known instructional procedures is "reciprocal teaching", developed by Brown and Palincsar (1989).  In order to improve their comprehension of a text, a teacher and a group of students collaborate in a series of strategic activities that included questioning, clarifying, summarizing and predicting.  In explaining the usefulness of summarizing, Brown and Palincsar point out that:

the students learned that summarizing was a test to see if they understood what had happened in the text.  If they could not summarize a section, it was regarded as an important indication that comprehension was not proceeding as it should, not as a failure to perform a particular skill.  (p. 414)

Through reciprocal teaching, students learn to monitor their own comprehension, and in the course of developing such self-awareness they learn how to learn (Brown, Campione & Day, 1981).  Brown and her collaborators have repeatedly found that students who engage in reciprocal teaching show significant improvement in comparison to students who do not, even if those students are given other forms of comprehension strategy instruction.  (See what I mean about the 'blahing'?)

Scardamalia & Bereiter

You wanted to see a Heading 3, didn't you?  Well, there it is, just above.  I guess I haven't mentioned this yet, but in case you don't know, all you have to do to set up a heading is type the text you want in the normal format you would use, then highlight it and then change it's style using the style pull-down.  For example, in the heading above, I just typed it as a normal paragraph – it did the small caps nonsense automatically.  Same for the other heading types – you don't need to make them caps or bold by hand, the style selection does that for you.

Chapter 2:
Method

Participants

Who were they?***

Materials and Apparatus

Stories

I made my kids read stories.  Wasn't that nice of me?  What materials did you or your participants use?

Computers and Programs Used to Conduct the Experiment

Maybe I was being a bit anal by including this section, but it seemed important at the time.  Blow it off it you want.

Design

Independent Variables

Experimental Condition.  Ok, finally!  Here's an example of how I handled heading levels 4 and 5.  For heading level 4 I used an underlined section heading followed by a period, as seen above.  For heading level 5 I used italicized text followed by a period (like the 'Full Feedback' heading below).  These I did by hand because I wanted them in-line with the following paragraph, and I couldn't figure out how to have a style apply to anything smaller than a paragraph. If you know how, let me in on it!  Since they're not automatic, you need to be careful that you're consistent.  Or just not use headings beyond level 3.  Alternatively, you could set up additional styles and have them on their own line (or paragraph) but I didn't because it looked like overkill to me. 

Full Feedback.  Participants in the Full Feedback condition received three types of information regarding the content of each of the summary drafts they wrote: the overall quality of the summary draft, identification of the best and worst summary sentences in the summary, and identification of possible redundancy between summary sentences. (blah……)
Gist Feedback.  Participants in the Gist Feedback condition performed the same tasks as the Full Feedback condition participants did.  However, the only feedback they received was an overall score of their summary.  This overall score was the same as the overall score described above.

Computer Only.  Participants in the Computer Only condition did stuff.

Paper.  Participants in the Paper condition did stuff too.

Story Order.  To address the possible influence of order effects, the experimental stories were presented to the participants in all possible orders.

Story Trial.  Over the course of the experiment, each of the 72 participants was asked to read and do a series of tasks associated with each of three short stories.  Their performance on each of the tasks was measured repeatedly, one time for each of the three Story Trials.  The order of presentation of the stories was different for different participants (as described above).  Thus, Story Trial is a participant-relative term.  Story1 refers to the first story (and performance on all of its associated tasks) as seen by the participant.  Story2 refers to performance during the second Story Trial.  Story3 refers to performance during the third and final Story Trial.

Dependent Variables

Human Summary Scores.  Three human graders assigned scores to the final drafts of each of the 216 summaries written by the participants in this experiment.  All of these graders were or had been language arts teachers in middle or elementary schools.  Their scores were meant to reflect the overall quality of the summary on a 1 to 10 point scale.

LSA Summary Cosines.  I'm not going to bore you with the details of this.  That is, unless you really want me to?  No?  Ok.

Word Count of Summary.  And many, many others….

Procedure

General Instructions

Upon arrival at the site of the experiment, each participant's identity as fluent speakers of English and as undergraduate students at the University of Colorado at Boulder was confirmed.  Could I have been anymore boring?

Story Trial Procedure

You no doubt get the idea by now, but here's another example of the use of Heading 4 indicators.

The Story Trial consisted of 7 components that are detailed below.  The participants iterated through the Story Trial procedure three times, once for each of the Story Trials.

Get the Short Story.  Participants were instructed to get the next short story from the experimenter.  At this point they were also reminded to return any materials they had used in the previous Story Trial.

Read the Short Story.  Participants were then instructed to read this short story.  They were encouraged to read it carefully, "as though it was course material that you would be responsible for having read in one of your classes."  After they finished reading, they were asked to indicate whether they had ever read the short story prior to the experiment.  

Blah.  More blah-blah steps.

Closing Activities

Following the Final Questionnaire, all of the participants were presented with a screen telling them that they had completed the experiment.  This screen is on page 30 of Appendix B.  After this, the experimenter provided them with an oral explanation of the motivation for and design of the experiment.  They were also given a paper copy of a brief explanation as well.  In addition, they were given a copy of the consent form that they had signed at the beginning of the experiment.  Finally, they were given the $20 reimbursement for their participation in the experiment and thanked very much for their participation.  (I sent them on their merry way!)

Chapter 3:
Results

Statistical Analysis Introduction and Assumptions

Here's a couple of examples of how I did the results.  In this section you'll get to see figures, captions, more normal – flush first lines, cross-references and (bonus!) how I chose to format the stats that I reported.

About figures and tables:  I included the figures in-line rather than doing the 'insert thingy about here' nonsense.  To do this, I pasted in the figure I made in StatView.  I formatted the figures in StatView – the figure size, the right font and font size, etc.  The important thing is the size – mine were 2.6" high by 5.6" wide.  Any wider and they will extend too far, go into the margins and get you into trouble with the Grad format reviewer.  Another thing: by default, Word lets a pasted picture float over the text, but I wanted more control than that.  So I made the picture appear as it's own paragraph… on it's own line.  Paste the figure onto that single-line paragraph.  Then select the figure, select 'Format > Picture' from the menu, and un-check the position control that allows the figure to float over the text.  Next, select the figure and change it to style 'Figure' from the style pull-down.  That will correctly position the figure on the page.

In the paragraph immediately following the figure, put in a figure caption.  You do this by Selecting 'Insert > caption' from the menu.  Make sure you've got the right label (in this case 'Figure') selected.  When you do it this way, Word keeps track of the numbering for you.  Type the text that you want to appear in the caption.  Finally, change this new caption paragraph to style 'Figure Caption'.  The List of Figures is made up of items that are of style 'Figure Caption'.  Leave it as just a caption, and it won't appear in the list.  Course, you can check that you've included them all by looking at the list and checking that all the numbers are there in order.

Finally, to make figures seem to appear in the middle of a paragraph, you need to have the paragraph following the figure caption be of style 'Normal – flush first line'.  Sometimes the size of the figure makes it too big to appear at the end of a page and instead it falls onto the next one.  However, that sometimes leaves a big blank on the end of the proceeding page.  So move some text between the paragraphs above and below the figure.  The styles automatically control orphan lines, and sometimes this interacts with the placement of figures (and footnotes too) … you just gotta play with it.

All of this also applies to tables too.  Instead of inserting pictures of tables, I made a bunch of styles for making a table using word out of text (I found real Word tables was more difficult to format).  So, look on 18 for an example.  If you move the cursor through it, you'll see the style of the top line is 'Table Top', those in the middle are 'Table', and the one on bottom is 'Table Bottom'.  Like figures, tables need to be followed by a caption, in this case a Table Caption.  You do this the same way as inserting a Figure Caption.  And, as with Figure Captions, Table Captions need to be that style to appear in the List of Tables.  Change the tab settings by selecting the whole table, then dragging the tab stops to where you want them to be (the tab stops are the little black right-angle thingies on the ruler).

Stats text: APA submission format is to underline statistics so that the publisher knows to italicize them.  What you give to the grad school on bond is the final format as it will be bound and in the library – so I went straight to the italicized version because I thought it looked better.  This is totally up to you, but be consistent.

Cross-references:  Since you've gone to all the trouble of making this formatting, you can use it to locate and reference things in your document.  You do this by selecting 'Insert > cross-reference' from the menu, then indicating the type of thing you want to cross-reference, the part of the thing that you want to have appear in the text, and then the exact thing you want referenced.  This ends up being very convenient for times (especially in the discussion) where you want to say (refer to Figure 1 on page 12).  If the thing in the text that you want do reference isn't specifically enough referenced by one of the headings or captions you've got, you can insert a bookmark to that thing ('Insert > Bookmark…' puts a bookmark where ever your cursor is), then cross-reference the bookmark.  Titles of bookmarks can't have any spaces in them, so I recommend using TheVariableNameConvention, and giving the bookmarks you create good descriptive titles.  This is especially important because the name of the cross-referenced bookmark appears when the cursor is placed over the cross-reference (that cross-reference also acts as a hyper-link.  Isn't that nice?)  You don't want those names to be confusing to your reader or embarrassing to you when they read it (if they happen to get it in Word or well-made Pdf format). 

A final note about cross-references: to update the cross-references in the text, click on the 'refresh current page' icon from the web toolbar.  You should save your document before you do this.  I think that by default, Word automatically updates the cross-references when you open a doc, when you save it and when you print it.  It's good to refresh (and save!! and back up!!!) your document often.  With massive hyperlinking, Word sometimes messes up and loses track of them – especially if there's been a lot of changes to the doc without updating the cross-references (don't ask me why, but that's been my experience).  Moral: refresh and save early; refresh and save often!  (As though you really needed to be reminded of that at this point in your career?!)

Overall Performance Changes

One method of assessing the change in the participants' performance over the course of the study is to look at how their performance on their first drafts changes across the three trials.  The average first draft-to-short story cosine for each condition across the three trials is presented in Figure 1.  The means and standard deviations of the cosines of each group in each story trial are presented in Table 2, on page 31 in Appendix C.  In this case, condition was a significant predictor of the amount of change across Story Trials in the cosine between the first draft of the summary and the short story, R = .237, F(1,70) = 4.150, p = .0454.  The cosines of the participants in the Full Feedback
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Figure 1.  The LSA cosines of the first drafts of the participants' summaries, grouped by condition and across story trial.

condition had a very slight tendency to increase over Story Trial.  The cosines of the participants in the Gist Feedback followed a pattern very similar to those in the Full Feedback condition, but in fact did not show a significant change over Story Trial.  The cosines of the participants in the Computer Only conditions also remained roughly the same throughout the experiment.  The cosines of the participants in the Paper condition had a slight tendency to decrease over Story Trial.  A detailed statistical analysis underlying these conclusions is presented in Table 3, on page 31 in Appendix C.

Another means of assessing the change in the participants' performance across the entire experiment is to look at the change in their performance from their very first draft (i.e., the first draft of Story1) to their very last draft (i.e., the last draft of Story3), as displayed in Figure 2.  (See Table 4, page 32 in Appendix C for the means and standard deviations of the cosines presented in Figure 2.)  The pattern of results here is very similar to that found when looking at the cosine of the first draft across all three trials
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Figure 2.  The LSA cosines of the participants' Story1 first draft and Story3 last draft summaries, grouped by condition.

 (see Figure 1).  Condition was a significant predictor of the amount of change from first draft of Story1 to the last draft of Story3 in the cosine between the summary draft and the short story, R = .239, F(1,70) = 4.243, p = .0431.  The cosines of the participants in the Full and Gist Feedback conditions tended to increase from the beginning to the end of the experiment.  The cosines of the participants in the Computer Only condition remained roughly the same from start to finish, whereas the performance of participants in the Paper condition showed a slight downward trend. (See Table 5 on page 32 in Appendix C for the detailed statistical analysis underlying these conclusions.)

Looking at the quality of the participants' performance at the end of the experiment (i.e., the cosine of the last drafts of their Story3 summaries or their "Very Last Draft" as seen in Figure 2), it is clear that the quality of final summary performance is in the predicted experimental order.  Participants in the Full Feedback condition wrote significantly better summaries than did participants in both the Computer Only condition and the Paper condition.  Participants in the Gist Feedback condition tended to write better summaries than did participants in the Computer Only condition, and wrote significantly better summaries than did participants in the Paper condition.  (For the specific values of the complete set of pair-wise comparisons of the participants' final draft performance, see Table 6 on page 32 in Appendix C.)  Roughly 16% of the variance in the participants' very last draft performance can be attributed to differences between the feedback conditions.

Additional Analyses

I had tons of 'em, so they went in another section with subsections for each type of analysis.  I've left a couple here so you can see what I mean.  I started this section with an introduction to the additional analyses.  I won't bore you with all of that here, only the first bit so you can see examples of hyperlinks.  To make a hyperlink, select 'Insert, Cross-reference…' from the menu.  Select the type of thing you want to link to (e.g., 'Figure' for the cross-references in the next paragraph), and the type of info you want to appear (the label and number in the links below; the page number in other places).

Both of the analyses of the participants' overall performance (seen in Figure 1 and Figure 2) reveal that the change, over time, in the participants' summaries depends on experimental condition.  This overall change is made up of two components: revision and transfer.  Revision is the direct consequence of feedback within a story trial.  Revision is assessed by an examination of the change from the first draft to the last draft of the summary within a single story trial.  Revision may result in changes in quality, changes in quantity, or both.  Change in quality is defined as the change in the caliber of the summary, specifically the change from the first draft-to-story cosine to the last draft-to-story cosine.  Change in quantity is defined as the change in the summary length, specifically the change in the number of words from the first summary draft to last summary draft.

Revision Quality

One possible and direct consequence of condition is revision.  A reasonable hypothesis is that feedback will result in greater change from first to last draft of a story summary.  The overall change in summary quality due to revision is measured by the change in LSA cosine between the summary draft and the story itself.  Figure 3 shows the average amount of change in
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Figure 3.  The mean change in LSA cosines (to the short story) from the first to the last summary draft, for each story trial and experimental condition.

quality due to revision for each group in each story trial.  (See Table 7 on page 33 of Appendix C for the means and standard deviations of the change in cosine from first draft to last draft for each story trial and each experimental condition.)

Story Trial was a significant predictor of the amount of revision performed, F(2,136) = 5.805, p = .0038.  Participants do more revision of their summary drafts in Story1 than they do in either Story2 or Story3, (see Table 8 on page 33 of Appendix C for values of the pair-wise comparisons).  Experimental condition itself does not significantly influence the change in cosine (R = .109, F(1,70) = .849, p = .3599), nor does Story Trial interact with experimental condition (R = .112, F(1,70) = .892, p = .3482).  Even when looking only at Story1 (the Story Trial in which the most revision occurred), amount of revision is not significantly related to experimental condition, R = .139, F(1,70) = 1.377, p = .2446.  Moreover, the amount of change in the cosine from first draft to last drafts is very small: the mean revision in cosine over all conditions and trials was .0120 (SD = .0373).  These two results indicate that the participants, regardless of experimental condition, are making only very minor changes in the content of their summaries while revising.

Transfer of Quality

A second possible consequence of feedback is transfer, or differences in the approach participants take to the summarization task that are a consequence of having received differing levels of feedback on previous trials.  To examine this effect, it is necessary to look at the differences in average performance between story trials, or differences between the last draft of one story trial and the first draft of the subsequent trial.  The average quality transfer across the two inter-story trials for each experimental condition appears in Figure 4.  The mean difference in cosine between the last and first summary drafts to the story (for each inter-story trial and averaged over the two inter-story trial episodes) for each experimental condition is given in Table 9 on page 34 of Appendix C.  When the analysis is
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Figure 4.  The mean difference in LSA cosines of the participants' last and first summary drafts from one trial to the next, averaged over both inter-story trial episodes and grouped by condition.
constrained to account for the anticipated order of the experimental conditions, experimental condition tends to have an effect on the difference in cosine between the last summary draft of one story trial to first draft of the next story trial (regardless of specific inter story trial episode), R = .206, F(1,70) = 3.089, p = .0832.  The quality of summaries written by participants in the Full Feedback and Gist Feedback conditions remains the same from one trial to the next, whereas the quality of summaries written by participants in the Computer Only and Paper conditions tends to decrease from trial to trial, (see Table 10 on page 34 in Appendix C for the individual comparisons).

Time on Task

To prevent fatigue, participants were restricted in the amount of time they could spend composing their story summaries.  In every Story Trial, all participants had as much time as they wished to write and review the first drafts of their summaries.  Once they had finished reviewing their summaries, if less than 15 minutes had transpired, they were given the option of revising their summaries and iterating through the revise and review process again.  However, if more than 15 minutes had passed since they first began composing their summaries in that Story Trial, they were automatically directed to the next task.  At no time were the participants ever explicitly aware of the time constraint.  The number of participants who stopped revising their summaries as a result of this time constraint is given in Table 1.


Story1
Story2
Story3
Total

Total
23
6
8
37

Full Feedback
12
2
4
18

Gist Feedback
6
2
3
11

ComputerOnly
4
1
1
6

Paper
1
1
0
2

Table 1.  The number of times the 18 participants in each condition and story trial were unable to do additional revision as a result of the 15 minute time constraint.

Overall, participants encountered this limitation significantly more often in Story1 than they did in the other two trials, F(2,136) = 16.207, p < .0001; Story1 to Story2 mean difference = .264, Fisher's PLSDCritDiff = .101, p < .0001; Story1 to Story3 mean difference = .236, Fisher's PLSDCritDiff = .101, p < .0001.  Across all trials, participants in the Full Feedback and Gist Feedback conditions encountered the time limitation more frequently than did participants in the other conditions, F(3,68) = 4.647, p = .0052.  The effect of experimental condition on frequency of encountering the time constraint was more pronounced in Story1 than in the other two stories, F(6,136) = 2.858, p = .0118.  In addition, participants were automatically directed on to the next task at the end of the review of their fifth draft.  Across all participants and all trials (216 in all), this limitation was met only once: one participant in the Gist Feedback condition produced 5 drafts of his summary in the first story trial.  Bearing in mind these two limitations in the available composition time, it is interesting to explore the amount of time the participants spent on various aspects of the summarization task.

Time Spent Writing First Draft

The amount of time the participants spent writing their first drafts of each story is given in Figure 5, (the group means and standard deviations associated with this figure appear in Table 11 on page 35 in Appendix C).  Keep in mind that this measure is unaffected by the time constraint described above.  Overall, participants spent less time composing their first drafts in successive Story Trials, F(2,136) = 5.125, p = .0071.  Averaging over all three Story Trials, when the analysis was constrained to account for the order of the
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Figure 5.  The average amount of time, in minutes, the participants in each condition spent writing the first drafts of their summaries in each Story Trial.

experimental conditions, participants in the higher levels of the experimental conditions spent more time composing their first drafts than did participants in the lower levels of the experimental conditions, R = .280, F(1,70) = 5.971, p = .0171.

Of principal importance is the fact that this relationship between first draft writing time and experimental condition becomes stronger over successive story trials.  In Story1, there is no significant relationship between experimental condition and writing time, R = .120, F(1,70) = 1.016, p = .3169.  By Story2, a significant relationship between experimental condition and writing time has become apparent, R = .260, F(1,70) = 5.081, p = .0273.  By Story3, this significant relationship is at it's strongest, R = .383, F(1,70) = 12.017, p = .0009.

Chapter 4:
Discussion

Overview of Findings

Overall

From the very beginning to the very end of the experiment, the quality of summaries written by the participants who received any sort of feedback about those summaries tended to increase.  The quality of the summaries written by the participants who performed the tasks on a computer but did not receive any feedback remained unchanged throughout the experiment, whereas the quality of summaries written by participants who did the tasks on paper (and received no feedback) tended to decrease.  This pattern of results is clearly visible in Figure 2 on page 13.

Interestingly, the performance of the participants in the two feedback conditions is indistinguishable.  Upon completion of each draft of a summary, participants in both of these groups received scores that indicated the quality of that summary draft.  However, participants in the Full Feedback group received additional information about the best and worst summary sentences in their summaries, as well as information about potentially redundant sentences.  Since the performance of these two groups is nearly identical, it appears that this difference in the amount of feedback they received had no discernable impact on their performance of the summarization task.

Revision

Quality of revision was measured as the change in cosine from first to last draft of a summary.  Quantity of revision was measured as change in word count from first to last draft.  Overall, participants engaged in very little revision, either when measured as change in cosine or change in word count.  However it is the case that participants engaged in significantly more revision, both in terms of quality and quantity of revision, in the first Story Trial than they did in either of the two subsequent Story Trials.  (See Figure 3 on page 15 for the pattern of revision quality over the course of the experiment.)  In fact, across all conditions, approximately 60% of the participants produced more than one draft in the first Story Trial.  This figure falls to approximately 42% for the second Story Trial, and only roughly 36% for the third and final Story Trial.  (Table 12 on page 35.)  Amount of revision, no matter how or when it was measured, was unaffected by experimental condition.

Time on Task

In looking at the time the participants spent producing their final summary drafts, each Story Trial was divided into three intervals: time spent writing the first draft, time spent reviewing the first draft, and any additional time spent revising the summary.  Overall, participants spent less and less time writing the first drafts of their summaries over the course of the experiment.  In spite of this, the positive correlation between experimental condition and first draft writing time grows stronger over the course of the experiment.  At the beginning of the experiment, there is no significant difference in first draft writing time between the groups.  By the end of the experiment, the mean first draft writing time of each of the four groups reflects the experimental condition order, with participants in the Full Feedback condition spending significantly more time than participants in either the Computer Only or the Paper conditions.  (Figure 5 on page 20.)

What's Going On?

An introduction to my highly speculative discussion section.  And for those of you who might ask: yes, I really did call these sections by these titles.  What can I say, I was a bit diss-drunk by that point!!  :)

What Can't Be Happening

There was a discussion of the theoretical explanations that could be eliminated by virtue of methodological, technical or other constraints.

What might be happening?

Serious speculations-ville here!  I outlined a series of hypotheses that could explain the phenomena I observed, and followed that with a proposal (and results interpretation) for an experimental design that would investigate that hypothesis.  I've included a few here so you can see that I used such a crazy format (and that no one seemed to mind!) 

• The feedback provided to participants in the Full and Gist Feedback conditions is simply a motivational prod that keeps them engaged in the activity, and this alone drives their superior performance.

· Include a placebo feedback condition.  If the participants in the new condition perform on par with participants in the genuine feedback conditions, this explanation is likely.  Otherwise, content-based, albeit minimal, feedback is having a more substantial impact than simple motivation.

• As has often been the case in previous studies (Hayes & Nash, 1997), the effect of experimental condition is primarily a consequence of the differing amounts of time that participants in the different experimental conditions spent engaged in the task.

· Replicate the study with required activity during a fixed composition interval.  If the overall effect of experimental condition on summary quality persists then it is likely that feedback, not merely time spent on the activity, is driving the effect.  Otherwise this alternative hypothesis is likely the case.

• Participants in the Full Feedback condition are unable to take complete advantage of the feedback provided because of the time limitation – which they encountered more often than other participants, especially in the first Story Trial – and therefore showed diminished performance relative to the other groups, especially in comparison to the Gist Feedback condition.

· Replicate the study without the time constraint on the composition time.  If the Full Feedback participants show performance superior to the Gist Feedback participants, this hypothesis is likely the case.  Otherwise, it's likely that in this experimental context, there is an upper limit to the benefit the participants receive from feedback.

General Conclusions

Have you gotten to this section yet?  Good for you!  You're almost done!  Keep on goin'… you're nearly at the end!!

I've included a couple of references in the next section just so you see the format.  As with the statistics type formatting, I didn't use the APA submission format, but the final publication format.  Change it if you want.  Also, I didn't set up a way to automatically populate the reference section based on the citations.  I hear you can do that using Endnote – but I didn't have that set up.  So… I did it by hand.  The best way I found was to print out the reference section at the end, then go through the document by hand, making sure the references were all in there, and were right.  This was also a chance to check that I used the right procedure for citing (all authors, when less than 6, on the first citation, then 'et al.' after that; year at first citation in a paragraph, then just authors after that).
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Appendix A1:
"Sniper" Short Story

THE SNIPER

By Liam O'Flaherty

The long June twilight faded into night. Dublin lay enveloped in darkness … 

It's a good story, but I doubt you want to read the whole thing right now.  I'm including parts of this story and the next as appendices so that you see how I handled single appendices (like Appendices B and C) and multi-part appendices like A1 and A2.

Appendix A2:
"Charles" Short Story

CHARLES 

by Shirley Jackson

The day my son Laurie started kindergarten…  

Again, it's a good story, but… 

Appendix B:
Example Screen Shots

Introduction and Demonstration Screens

Welcome Screen
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General Instructions Screen
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End Experiment Screen
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Appendix C:
Data Tables


Mean
Std.Dev.

FirstDraft Cosine, Story1, Full Feedback
.6321
.0923

FirstDraft Cosine, Story1, Gist Feedback
.6261
.1290

FirstDraft Cosine, Story1, Computer Only
.6227
.1028

FirstDraft Cosine, Story1, Paper
.6114
.1107

FirstDraft Cosine, Story2, Full Feedback
.6613
.0850

FirstDraft Cosine, Story2, Gist Feedback
.6523
.1102

FirstDraft Cosine, Story2, Computer Only
.6275
.1001

FirstDraft Cosine, Story2, Paper
.5938
.0847

FirstDraft Cosine, Story3, Full Feedback
.6687
.1194

FirstDraft Cosine, Story3, Gist Feedback
.6545
.0663

FirstDraft Cosine, Story3, Computer Only
.6033
.1060

FirstDraft Cosine, Story3, Paper
.5658
.1087

Table 2.  The mean cosine of the first draft summary, for each story trial and condition.


Mean
df
t
p
FirstDraft Cosine Slope, Full Feedback
.0183
17
1.299
.2742

FirstDraft Cosine Slope, Gist Feedback
.0142
17
.8439
.4104

FirstDraft Cosine Slope, Computer Only
-.0097
17
-.6385
.5317

FirstDraft Cosine Slope, Paper
-.0228
17
-1.3254
.2026

Table 3.  The mean slope of the change in the first draft cosines across the three Story Trials, as well as the t-test values comparing these mean slopes to zero (i.e., no change) for each condition.


Mean
Std.Dev.

FirstDraft Cosine, Story1, Full Feedback
.6321
.0923

FirstDraft Cosine, Story1, Gist Feedback
.6261
.1290

FirstDraft Cosine, Story1, Computer Only
.6227
.1028

FirstDraft Cosine, Story1, Paper
.6114
.1107

LastDraft Cosine, Story3, Full Feedback
.6750
.1172

LastDraft Cosine, Story3, Gist Feedback
.6654
.0531

LastDraft Cosine, Story3, Computer Only
.6065
.1045

LastDraft Cosine, Story3, Paper
.5789
.0943

Table 4.  The mean Very First Draft (i.e., First Draft of Story1) and Very Last Draft (i.e., Last Draft of Story3) cosines, for each experimental condition.


Mean
df
t
p
Extreme Cosine Slope, Full Feedback
.0428
17
1.334
.1998

Extreme Cosine Slope, Gist Feedback
.0393
17
1.248
.2289

Extreme Cosine Slope, Computer Only
-.0162
17
-.533
.6010

Extreme Cosine Slope, Paper
-.0324
17
-1.102
.2860

Table 5.  The mean slope of the change in the cosines from very first to very last draft, as well as the t-test values comparing these mean slopes to zero (i.e., no change) for each experimental condition.


MeanDiff.
Crit.Diff.
p
VeryLastDraft Cosine, Full vs. Gist
.0095
.0634
.7649

VeryLastDraft Cosine, Full vs. Computer
.0684
.0634
.0349

VeryLastDraft Cosine, Full vs. Paper
.0960
.0634
.0035

VeryLastDraft Cosine, Gist vs. Computer
.0589
.0634
.0683

VeryLastDraft Cosine, Gist vs. Paper
.0865
.0634
.0083

VeryLastDraft Cosine, Computer vs. Paper
.0276
.0634
.3881

Table 6.  Fisher's PLSD values for the pair-wise comparisons of the last draft cosine of Story3 for each condition.


Mean
Std.Dev.

CosineRevision, Overall
.0120
.0373

CosineRevision, Story1, Full Feedback
.0338
.0695

CosineRevision, Story1, Gist Feedback
.0289
.0583

CosineRevision, Story1, Computer Only
.0181
.0608

CosineRevision, Story1, Paper
.0148
.0211

CosineRevision, Story2, Full Feedback
.0070
.0172

CosineRevision, Story2, Gist Feedback
-.0004
.0258

CosineRevision, Story2, Computer Only
.0041
.0178

CosineRevision, Story2, Paper
.0040
.0086

CosineRevision, Story3, Full Feedback
.0063
.0118

CosineRevision, Story3, Gist Feedback
.0109
.0304

CosineRevision, Story3, Computer Only
.0032
.0119

CosineRevision, Story3, Paper
.0132
.0364

Table 7.  The mean change in the LSA cosines (to the short story) from the first to the last summary drafts, overall and for each story trial and condition.


MeanDiff.
Crit.Diff.
p
CosineRevision, Story1 vs. Story2
.0202
.0123
.0014

CosineRevision, Story1 vs. Story3
.0155
.0123
.0138

CosineRevision, Story2 vs. Story3
-.0047
.0123
.4480

Table 8.  Fisher's PLSD values for the pair-wise comparisons of change in cosine in each Story Trial.


Mean
Std.Dev.

CosineTransfer, Overall
-.0138
.1201

CosineTransfer, Between12, Full Feedback
-.0047
.1118

CosineTransfer, Between12, Gist Feedback
-.0027
.1357

CosineTransfer, Between12, Computer Only
-.0132
.1444

CosineTransfer, Between12, Paper
-.0324
.0905

CosineTransfer, Between23, Full Feedback
.0004
.1129

CosineTransfer, Between23, Gist Feedback
.0026
.0963

CosineTransfer, Between23, Computer Only
-.0283
.1505

CosineTransfer, Between23, Paper
-.0319
.1226

CosineTransfer, Average, Full Feedback
-.0021
.0555

CosineTransfer, Average, Gist Feedback
-.0000
.0569

CosineTransfer, Average, Computer Only
-.0208
.0584

CosineTransfer, Average, Paper
-.0322
.0700

Table 9.  The change in the LSA cosines (to the short story) from the last summary draft of one story trial to the first summary draft of the next story trial, for each condition, for each inter-story trial episode and averaged across the two inter-story trial episodes.


Mean
df
t
p
CosineTransfer, Average, Full Feedback
-.0021
17
-.1641
.8716

CosineTransfer, Average, Gist Feedback
-.0000
17
-.0035
.9972

CosineTransfer, Average, Computer Only
-.0208
17
-1.5074
.1501

CosineTransfer, Average, Paper
-.0322
17
-1.9516
.0677

Table 10.  The mean difference in the cosines from the end of one Story Trial to the beginning of the next, as well as the t-test values comparing these mean differences to zero (i.e., no difference) for each experimental condition.


Mean
Std.Dev.

FirstDraftWriteMinutes, Story1, Overall
8.7211
5.6509

FirstDraftWriteMinutes, Story1, Full Feedback
9.7331
7.0929

FirstDraftWriteMinutes, Story1, Gist Feedback
9.1134
7.2820

FirstDraftWriteMinutes, Story1, Computer Only
7.9024
3.7181

FirstDraftWriteMinutes, Story1, Paper
8.1355
3.7259

FirstDraftWriteMinutes, Story2, Overall
7.6726
3.1474

FirstDraftWriteMinutes, Story2, Full Feedback
8.4717
2.2858

FirstDraftWriteMinutes, Story2, Gist Feedback
8.4200
3.3381

FirstDraftWriteMinutes, Story2, Computer Only
7.4165
3.6201

FirstDraftWriteMinutes, Story2, Paper
6.3821
2.9662

FirstDraftWriteMinutes, Story3, Overall
6.9972
3.1950

FirstDraftWriteMinutes, Story3, Full Feedback
9.0190
3.4791

FirstDraftWriteMinutes, Story3, Gist Feedback
7.0453
3.4814

FirstDraftWriteMinutes, Story3, Computer Only
6.2668
2.2066

FirstDraftWriteMinutes, Story3, Paper
5.6577
2.5974

Table 11.  The mean time spent writing the first draft summary, in minutes, for each Story Trial and experimental condition.


Story1
Story2
Story3
Total

Total
29
42
46
117

Full Feedback
8
11
12
31

Gist Feedback
5
10
12
27

ComputerOnly
7
11
11
29

Paper
9
10
11
30

Table 12.  The number of times the 18 participants in each condition and story trial produced only one (first) draft of their summary.

































































































� Here's an example footnote.  Sometimes the way Word chooses to handle the placement of them can be annoying.  You just have to play with it a bit – sometimes moving some text around between pages, above and below figures and between paragraphs of Normal and Normal – flush first line style. 


� This pattern of minimal change due to revision is mirrored in the actual cosine between first draft and last draft of the summary in the three Story Trials.  For all participants, the mean cosine between the first draft and the last draft in Story1 was .954 (SD = .097), in Story2 was .986 (SD = .031) and was .985 (SD = .046) in Story3.


� To facilitate their presentation here, the screenshots have been reduced in size.  As originally displayed to the participants, the screenshots were 6.25 inches in width and 5.5 inches in height.
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